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Chapter 1. Getting Started

ODBC with Sterling Gentran:Server
ODBC (Open Database Connectivity) provides the ability to specify several data
sources so that the system can query or update multiple databases during
translation. Map creation directly from a database schema saves time and ensures
that your map is synchronized with the latest version of your database.

IBM® Sterling Gentran:Server® for Microsoft Windows enables you to manage
ODBC (Open Database Connectivity) documents along with traditional electronic
commerce messages in the same manner. This allows you to maintain a
homogenous processing and data management environment, regardless of how the
incoming and outgoing data is formatted (for example, ODBC, XML, proprietary
message formats).

Sterling Gentran:Server enables you to:
v Specify data sources that the system uses to query for data or update data in

multiple databases in a single translation session.
v Add data sources and then test the connection and edit the connection string.
v View a model of the database schema, including lists of tables and columns.
v Generate fields directly from your database schema.
v Check the consistency of your database.

Notes:

v If you use the ODBC syntax on both sides of a map, each side uses a separate
set of data sources. One side cannot refer to the data sources belonging to the
other side of the map.

v ODBC features cannot be inserted in any other type of map.
v Any ODBC map that uses an ODBC Output Record and is translating against a

Microsoft database (Access or SQL Server) must turn on (activate) the "Use ANSI
Quoted Identifiers" option in the ODBC DSN configuration.

Timestamp information

Sterling Gentran:Server will place a timestamp of 00:00:00.000 on the end of any
date which is written to the Sterling Gentran:Server database without a timestamp,
regardless of the type of database management system you are using.

Customer Support

If you are unable to resolve a problem, collect the following information before
calling customer support:
v Name of the database to which you are mapping
v MDAC version
v Version of database including any service packs applied
v Table scripts with column, key, and index information
v Maps
v Data file

© Copyright IBM Corp. 1996, 2012 1



v Partner profile
v Exact error messages you received
v Date and time stamp on the MAPPER.EXE and TX32.EXE files in your GENSRVNT\Bin

folder
v Description of how the map should function

About ODBC Maps
Sterling Gentran:Server uses a set of icons to represent ODBC map objects.

Types of maps

The following table describes the different map types.

Map Type Description

Import Used for outbound maps.

Export Used for inbound maps.

Interchange break Used in advanced mapping to separate interchanges.

Functional
Acknowledgement
Inbound

Used in advanced mapping to reconcile functional
acknowledgements.

Functional
Acknowledgement
Outbound

Used in advanced mapping to generate functional
acknowledgements.

System Import Header Used to determine which trading relationship (established in
Partner Editor) corresponds to each document in the application
file, so the system knows which import translation object to use
to process the document.

Turnaround Used for EDI to EDI maps.

Transaction build Used in advanced mapping to build transaction envelopes.

Transaction break Used in advanced mapping to separate documents.

Functional group build Used in advanced mapping to build functional group envelopes.

Functional group break Used in advanced mapping to separate functional groups.

Interchange build Used in advanced mapping to build interchange envelopes.

ODBC Map Objects

This table describes the map object icons that Sterling Gentran:Server uses to
visually represent the ODBC file:

Icon Description

The ODBC File Format icon contains the ODBC data sources that Sterling
Gentran:Server uses during translation, including the root element. It is a
looping structure that contains groups, SQL statements, cursor operations,
and input and output records that repeat in sequence until either the group
data ends or the maximum number of times that the loop is allowed to
repeat is exhausted.

A group is a looping structure that contains related groups, statement
records, cursor operations, and input and output records that repeat in
sequence until either the group data ends or the maximum number of times
that the loop is allowed to repeat is exhausted.
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Icon Description

A statement record represents a unit of SQL. This includes a SQL query
(which may or may not return a result set), a command (which does not
return a result set), or a stored procedure invocation (which may or may not
return a result set).

A cursor operation record contains instructions for the translator on moving
to a new record in a result set returned by a query. Each operation is
associated with a single statement record that returns a result set. The
cursor operation record is only allowed on the input side of the map.

An input record contains a logical group of fields that are suitable to be
mapped to the output format. The input record is only allowed on the input
side of the map.

An output record represents update, insert, or delete SQL statements, and
contains fields. Output records may be created on both the input and
output sides of a map.

The field corresponds to a column in a database table and contains the
attributes of that column. On the input side, the field receives data from a
column of the current row of the open SQL query. On the output side, the
field represents a column the system updates or inserts, or a key column.
Additionally, you can create fields that are not related to a database table or
result set of a query.

ODBC Map Creation Process
This topics describes the process that you follow to use ODBC with Sterling
Gentran:Server.

Build the input and output sides of the map in the following sequence.

Stage Description

1 Add data sources and test the connection.

2 If necessary, use the ODBC field generator to generate database fields.

3 If necessary, create map objects manually.

4 Verify the consistency of the database.

Considerations for ODBC Mapping
Review these considerations before beginning to create your ODBC map.

Import processing

For outbound processing, you need a way to determine which records in your
database tables were processed. Therefore, you need to be able to mark records so
that when you process the map you can select only the unprocessed records in
your tables.

To mark records as processed or not processed, you need to designate a column in
your database to contain a processing flag. This can be a process column that you
insert into your database or you may select an unused column to perform this
function. You need to incorporate this column into the SQL statement record in
your map. Also, you need to update this column from the map to indicate that a
data record was processed.
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Note: Before adding a process column to your database or changing the function
of an existing column, we recommend that you copy your data to separate work
tables in your database, to ensure that your testing will not overwrite existing data.

Export processing

Sterling Gentran:Server enables you to export data directly to a database. To export
a document to an ODBC compliant database (i.e., EDI to ODBC), you must register
an export translation object for that transaction set, and you must set up that
export translation object and an export file name in the inbound relationship
record for that partner.

See the following topics in the IBM Sterling Gentran:Server for Microsoft Windows
User Guide:
v Exporting a Document
v Registering a Translation Object
v Creating a New Inbound Relationship

Tips for Inbound Mapping

Inbound maps can use any format on the Input side and ODBC format on the
Output side.

The following list contains general guidelines for inbound mapping.
v Any insert/update actions are not performed to the database until the Export

process.
v If the export process contains any errors, the errors are notated in the Export

Summary translator report located in the External Data browser, which is
accessed from the Sterling Gentran:Server main window.

v If you are unable to determine why your map does not write to your database,
you should run a database trace (not an ODBC trace) for the Export process only
(not the process file).

v The database trace file supplies you with all the SQL statements built from the
map by Sterling Gentran:Server, and also provides the rollback. If you need
further details, you can execute the SQL statements through a query analyzer.

Tips for Outbound Mapping

Outbound maps use ODBC format on the Input side and can use any format on
the Output side.

If your map is executing an infinite loop, you should verify the items in the
following list.
v Determine whether the SQL Statement Record (located in the map) is checking

for a specific value in a table column.
v Verify that you included an update record in the import map.
v Ensure that the update record contains the key columns for the table that is

updated.

Creating an ODBC Map
The New Map Wizard enables you to quickly and easily select the format of the
input and output files and create a map.
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About this task

Note: If you use the ODBC syntax for both sides of the map, each side uses a
separate set of data sources and one side cannot refer to the data sources that
belong to the other side of the map.

Use this procedure to create an ODBC map.

Procedure
1. From the Start menu, select Programs > Gentran Server > Application

Integration.
The system displays the Application Integration subsystem.

2. Select File > New.
The system displays the New Map Wizard.

3. Enter the following information and click Next.
v Select the type of map you want to create.
v Enter the unique name of the map. The system adds the .MAP extension.
v Type your name if it differs from the user name prompted by the system.
The system displays the New Map Wizard - Input Format dialog box.

Note: You need to complete the format of the Input side of the map. This is the
format of the data that is translated by the Sterling Gentran:Server system.

4. For the input side of the map, do one of the following:
v To create a new data format using a syntax that you define, select one of the

input format options. Continue with step 5.
v To load the data format from a saved definition, select Load the data format

from a saved definition. Either enter the path and filename or navigate to
the saved definition.

5. For the output side of the map, do one of the following:
v To create a new data format using a syntax that you define, select one of the

input format options.
v To load the data format from a saved definition, select Load the data format

from a saved definition. Either enter the path and file name or navigate to
the saved definition.

6. Click Finish to begin editing the map. (This may take a few seconds).
The system displays the new map in the Application Integration Window.

What to do next

After you finish creating and saving a new map, you need to define the Input and
Output sides of the map.

Additional Steps for Import Maps
For outbound processing with many partners, we recommend you create an ODBC
import map (such as ODBC to positional) because it is much easier than creating a
system import map for this task.

See the Importing Documents topic in the IBM Sterling Gentran:Server for Microsoft
Windows User Guide for more information.
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This table describes an example of the process for creating an ODBC import map
for use with many partners in Sterling Gentran:Server.

Stage Description

1 Create an import map (such as ODBC.MAP, with a description of "ODBC
Import"). See Creating an ODBC Map for more information.

2 On the input side of the map, define a 3-field alternate key to look up
partner information (as if you were creating a system import map).
Note: This import map will contain the functionality of both an import map
and a system import map.

See the "How to Define the Alternate Key" section in the IBM Sterling
Gentran:Server for Microsoft Windows Application Integration User Guide for
more information.

3 Create an empty file (such as ODBC.IN).
Note: You can use a text editor to create the dummy file. The dummy file is
used to trigger the import process.

4 On the System Configuration program Imports tab, associate the compiled
import translation object with the empty file.
Note: This instructs the system to use the import map instead of a system
import map when the dummy file is imported into the system. When the
import is performed, the system runs all the ODBC translation specified by
the map.

See the Defining a New Import Specification topic in the IBM Sterling
Gentran:Server for Microsoft Windows Administration Guide for more
information.

The Generate Fields Function
The Generate Fields function is a wizard that enables you to quickly and easily
generate fields for an input or output record. The functionality differs slightly
depending on whether the record is input or output.

Note: Before using this function, you should test your SQL queries. See ODBC File
Format Object for more information on testing queries.

Generating Input Record Database Fields
The Generate Fields function is a wizard that enables you to quickly and easily
generate fields for an input record.

About this task

Use this procedure to generate input record database fields.

Procedure
1. Right-click an input record and select Generate Fields.

The system displays the ODBC Field Generator Wizard.
2. From the Queries list, select the defined queries and click Next.

Note: The system only displays the queries for which you generated a result
set.

3. From the Columns list, select the desired result columns and click Finish.
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Note: Click Choose All to select all columns. Click Clear to deselect all
columns.
The system adds the specified result columns to the record and automatically
generates all the validation settings.

Generating Output Record Database Fields
The Generate Fields function is a wizard that enables you to quickly and easily
generate fields for an output record.

About this task

Use this procedure to generate output record database fields.

Procedure
1. Right-click an output record and select Generate Fields.

The system displays the ODBC Field Generator Wizard.
2. If the output record is not already associated with a data source, select the

desired data source.
3. If the output record is not already associated with a table, select the desired

database table.
4. Select the table operation and click Next.
5. From the Columns list, select the desired result columns and click Finish.

Note: Click Choose All to select all the columns. Click Clear to deselect all
columns.
The system adds the specified result columns to the record and automatically
generates all the validation settings.

Moving from Test to Production
If your ODBC data source name (DSN) is different on the test and production
controllers, you will need to change the ODBC DSN for the maps you are using in
production.

Before you begin

When you move from a test to a production environment, you must verify that the
following items are identical on both the development (test) controller and the
production server.
v MDAC version
v Database name (if the database name is different on the production controller,

you must change the name in the map)
v Data source names (if the database name is different on the production

controller, you must change the name on the ODBC File Properties dialog box in
the map)

About this task

Use this procedure to change the ODBC data source name when you move from
test to production.
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Procedure
1. In each map that you are moving from test to production, right-click the ODBC

File icon and select Properties.
The system displays the ODBC File Properties dialog box.

2. Select the Data Sources tab to access the data source options.
3. In the DSN box, type the ODBC data source name for your production

database.
The system changes the DSN for this map.

4. Click OK.
The system closes the ODBC File Properties dialog box.
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Chapter 2. Working with ODBC Map Objects

About Creating Map Objects
The map objects that you can create depends on which map object is currently
selected.

This table describes the available options. N/A indicates that no map object can be
created when the specified object is selected.

If the currently-selected object is
a... Then you can create...

ODBC File Format v Group

v Statement Record

v Cursor Operation Record (input only)

v Input Record (input only)

v Output Record

Group v Group

v Statement Record

v Cursor Operation Record (input only)

v Input Record (input only)

v Output Record

Statement Record
(Query/Command)

N/A

Cursor Operation Record N/A

Input Record Field

Output Record Field

Field N/A

The Create Sub and Insert functions

You use two different Sterling Gentran:Server functions to create the necessary
map objects—Create Sub and Insert.
v Use Insert when you want to create a map object at the same level (equal) as the

selected map object.
v Use Create Sub when you want to create a map object that is subordinate to the

selected map object (a child object).

ODBC File Format Object
The ODBC File Format object represents the ODBC data sources that Sterling
Gentran:Server is mapping, including the root element.

This object is created automatically by Sterling Gentran:Server and enables you to
define ODBC data sources, connection parameters, and extended rules.

Note: The ODBC File Format object cannot be referenced by standard rules or
links.
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Important: Any ODBC map that uses an ODBC Output Record and is translating
against a Microsoft database (Access or SQL Server) must turn on (activate) the
"Use ANSI Quoted Identifiers" option in the ODBC DSN configuration.

ODBC File Format Properties - Name Tab
This table describes the ODBC File Format Properties Name tab.

Part Function

Name Identifies the ODBC file.

Description Describes the ODBC file. This box is used to differentiate the
ODBC file from similar files.

ODBC File Format Properties - Data Sources Tab
This table describes the ODBC File Format Properties Data Sources tab.

Part Function

Currently Defined Data
Sources

Displays the currently defined data sources.

DSN Specifies the data source name, as identified by ODBC.
Note: Each DSN must be unique.

UID Specifies the user ID, if necessary.
Note: Complete if you use a DSN that requires a connection.

PWD Specifies the password, if necessary.
Note: Complete if you use a DSN that requires a connection.

DATABASE Specifies the database name.

User supplied name for
this data source

Indicates how you want to refer to the data source name.
Note: Complete if this name is different from the ODBC DSN.
This is the DSN, as known by the map which the system
propagates to all applicable Properties dialog boxes.

Connect to data source to
build table schema and
test SQL statements

Indicates that the system connects to this data source and uses
that information to build the database table schema and test the
SQL queries (thus generating a result set).

Use Transaction Indicates that the translator performs all the operations on the
data source in a transaction.
Note: If there is a database error during translation, the system
rolls the database back to a previous state that does not contain
errors.

ODBC Data Sources Accesses the Select Data Source dialog box, which enables you
to create a data source or select one that was previously
created.

Clear Selected Data
Source

Clears the parameter boxes to allow you to add another data
source.

Test Connection Tests the connection of the selected ODBC data source.
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Part Function

Update/Add Rebuilds the database schema for the selected data source if
you specified Test Connection. After the system rebuilds the
schema, it automatically checks all the objects in the file format
that depend on that schema. If possible, the system also
modifies the data-type and validation information for those
objects to match the new schema. Then, the system performs a
consistency check and fixes those inconsistencies.
Note: If you do not select a data source or there are no data
sources in the list, the system displays Update as Add, which
allows you to add a data source you previously created to the
Currently Defined Data Sources list.

See Checking Database Consistency for more information.

Remove Deletes the selected data source from the list, which invalidates
(clears) all fields or records that reference it.
Note: You are prompted to remove the selected data source
(from the list, not from the machine). Click OK to do so.

ODBC File Format Properties - Loop Extended Rules Tab
This table describes the ODBC File Format Properties dialog box Loop Extended
Rules tab.

Part Function

On Begin Specifies that the extended rule is executed before the system
processes the map object.

On End Specifies that the extended rule is executed after the system
concludes processing the map object.

Full Screen Maximizes the dialog box.

Compile Compiles the extended rule. Any warnings or errors are
displayed in the Errors list.
Note: This function gives you immediate feedback about the
accuracy of your rule. The rule is compiled when you compile
the entire translation object.

Extended rule Defines the extended rule.

Errors Displays any errors generated when you clicked Compile to
compile the extended rule.

Modifying ODBC File Format Properties
About this task

Use this procedure to modify the properties of an ODBC file.

Procedure
1. Right-click the ODBC file icon and select Properties.

The system displays the ODBC File Properties dialog box.
2. To create an ODBC data source, select the Data Sources tab.

See Creating an ODBC Data Source for more information.
3. To specify an extended rule for the ODBC file select the Loop Extended Rules

tab to define the rule.
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See the IBM Sterling Gentran:Server for Microsoft Windows Application Integration
User Guide for more information on extended rules.

4. Click OK.
The system saves your changes and closes the ODBC File Properties dialog box.

Creating an ODBC Data Source
About this task

Use this procedure to create an ODBC data source.

Procedure
1. Right-click the ODBC file icon and select Properties.

The system displays the ODBC File Properties dialog box.
2. Select the Data Sources tab to access the data source options.
3. Click ODBC Data Sources.

The system displays the Select Data Source dialog box.
4. To select a machine data source, select the Machine Data Source tab and do the

following:
v Select the machine data source and click OK.
v Verify the login information and click OK.

Note: Sterling Gentran:Server does not support File Data Sources.
5. On the ODBC File Properties Data Sources tab, complete the following items

and click Add:
v DSN (required)
v Database (optional)
v Password (optional)
v User defined name for this Data Source (optional)
The system adds the data source to the list and prompts you that it is building
the schema for that data source.

6. To test the connection to a data source, select the data source and click Test
Connection.

Note: If you click Test Connection, the system attempts to rebuild the schema
whenever you perform an update or check database consistency, and it tests all
queries running against that data source.
The system tests the connection of the selected data source and prompts you
with a dialog box containing the results of the test. Click OK to exit the dialog
box.

7. Click OK.
The system closes the ODBC File Properties dialog box.

Groups

Group Properties - Name Tab
A group contains related groups, SQL statements, cursor operations, and input and
output records that repeat in sequence until either the group data ends or the
maximum number of times that the loop is allowed to repeat is exhausted. The
group object cannot be referenced by standard rules or links.
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This table describes the parts of the Group Properties Name tab.

Part Function

Name Identifies the group name.
Note: Do not use spaces or dashes (-) in the group name. You
can use the underscore (_) to separate words.

Description Describes the group to differentiate it from other similar
groups.

Group Properties - Looping Tab
A group contains related groups, SQL statements, cursor operations, and input and
output records that repeat in sequence until either the group data ends or the
maximum number of times that the loop is allowed to repeat is exhausted. The
group object cannot be referenced by standard rules or links.

This table describes the parts of the Group Properties Looping tab.

Part Function

Minimum Usage Specifies the minimum number of times the loop must be
repeated. For a conditional loop, the minimum usage should
always be "0" (zero).

Maximum Usage Specifies the maximum number of times the loop can be
repeated.

Promote records to
parent

Indicates that when the group is compiled, the subordinate
records and groups will be extracted from the loop and located
in the parent group. This function is valid for single iteration
subgroups only.

Group Properties - Loop Extended Rules Tab
A group contains related groups, SQL statements, cursor operations, and input and
output records that repeat in sequence until either the group data ends or the
maximum number of times that the loop is allowed to repeat is exhausted. The
group object cannot be referenced by standard rules or links.

This table describes the parts of the Group Properties Loop Extended Rules tab.

Part Function

On Begin Specifies that the extended rule is executed before the system
processes the map object.

On End Specifies that the extended rule is executed after the system
concludes processing the map object.

Full Screen Maximizes the dialog box.

Compile Compiles the extended rule. Any warnings or errors are
displayed in the Errors list.

Extended rule Defines the extended rule.

Errors Displays any errors generated when you clicked Compile to
compile the extended rule.
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Creating a Group
About this task

Use this procedure to create a group.

Procedure
1. Right-click a map object and select either Create Sub > Group or Insert >

Group.
See About Creating Map Objects for more information on the Create Sub and
Insert functions.
The system displays the Group Properties dialog box.

2. On the Name tab, enter a unique group name and description (if applicable).
3. Select the Looping tab.
4. In the Minimum Usage box, type the minimum number of times the loop must

be repeated.

Note: For a conditional loop, the minimum usage should always be "0" (zero).
For a mandatory loop, the minimum usage should be "1" or greater.

5. In the Maximum Usage box, type the maximum number of times the loop can
be repeated.

6. If this is a single iteration group and you want the subordinate records and
groups to be located in the parent group, select Promote records to parent.

7. To specify an extended rule for this group, select the Loop Extended Rules tab.
See the IBM Sterling Gentran:Server for Microsoft Windows Application Integration
User Guide for more information on extended rules.

8. Click OK.
The system saves the element and closes the Group Properties dialog box.

Statement Records
The statement record represents a SQL query (which returns data and can be used
later in the map) or command. Each statement record is associated with a single
data source. If the schema for that data source already exists, the system displays
all the tables for your reference.

To use a statement record, you first select a data source. If a schema was generated
for the selected data source, the system displays a list containing all the tables and
views.

Then, you can type a SQL statement, test its validity, and generate a result set of
columns returned from the query or stored procedure. This result set is used in the
ODBC field generator for input records. Then you can connect to the data source
and test it.

If you specify the name of a stored procedure instead of a SQL statement, you
must select the stored procedure option.

Note: The statement record cannot be referenced by standard rules, extended rules,
or links.
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ODBC Statement Record Properties - Name Tab
This table describes the parts of the ODBC Statement Record Properties Name tab.

Part Function

Name Defines the statement record name.

Description Describes the statement record.

ODBC Statement Record Properties - SQL Tab
This table describes the parts of the ODBC Statement Record Properties SQL tab.

Part Function

Data Source Contains a list of all the data sources associated with this side
of the map.

SQL Statement Enables you to type SQL.
Note: This box also accepts C-style comments.

For example:

/*This is a comment*/

Full Screen Maximizes the SQL statement list.

Returns a Result Set Indicates that the system should generate and return a result
set for the specified SQL.

SQL statement is a stored
procedure

Indicates that the entry in the SQL Statement list is a stored
procedure instead of a query or command.

Test SQL Tests the statement in the SQL Statement list.

Tables Contains a list of database tables and views associated with the
selected data source.

Column Info Contains the column information from the selected database
table.
Note: The data type displayed is the Sterling Gentran:Server
data type of the column, not the actual database data type.

Creating a Statement Record
About this task

Use this procedure to create a statement record.

Procedure
1. Right-click a map object and select either Create Sub > Query/Command or

Insert > Query/Command from the shortcut menu.
See About Creating Map Objects for more information on the Create Sub and
Insert functions.
The system displays the ODBC Statement Record Properties dialog box.

2. On the Name tab, enter a unique statement record name and description (if
applicable).

3. Select the SQL tab to access the statement options.
4. From the Data Source list, select the data source you want to use for this

statement.
5. In the SQL Statement list, type the SQL statement or stored procedure.
6. If necessary, select SQL statement is Stored Procedure.
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7. If you want the system to return a result set when you test the statement, select
Returns a Result Set and click Test SQL.

Note: This function is only valid if you selected Test Connection on the ODBC
File Format Properties dialog box.
See ODBC File Format Object for more information.
The system tests the statement and, if specified, returns a result set.

8. Click OK.
The system saves the statement record and closes the ODBC Statement Record
Properties dialog box.

Cursor Operation Records
The cursor operation record contains instructions for the translator on moving
through the result set to a new record. Each cursor operation record is associated
with a single ODBC statement record.

Note: Cursor operation records are only allowed on the input side of a map.

The system performs cursor operations when they are encountered by the
translator as it processes the map.

Note: The cursor operation record cannot be referenced by standard rules,
extended rules, or links.

ODBC Cursor Operation Record Properties - Name Tab
This table describes the parts of the ODBC Cursor Operation Record Properties
Name tab.

Part Function

Name Defines the cursor operation record name.

Description Describes the cursor operation record.

ODBC Cursor Operation Record Properties - Cursor Operation
Tab

This table describes the parts of the ODBC Cursor Operation Record Properties
Cursor Operation tab.

Part Function

Query Record Association Contains the statement record of type "query" with which you
associate the cursor operation.
Note: The statement record must return a result set.
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Part Function

Cursor Operation Contains the operation that the translator performs on the
result set. Valid selections are as follows.

v No Op - Performs no operation and enables you to test the
effect of removing a cursor operation without actually
removing the object.

v Move First - Move the cursor to the First row of the result set
returned by the Associated Query selected.

v Move Next - Move the cursor to the Next row of the result
set returned by the Associated Query selected.

v Move Last - Move the cursor to the Last row of the result set
returned by the Associated Query selected.

v Move Previous - Move the cursor to the previous row of the
result set returned by the Associated Query selected.

v Close - Close the cursor opened for the Associated Query
selected.

Creating a Cursor Operation Record
About this task

Use this procedure to create a cursor operation record.

Procedure
1. Right-click a map object and select either Create Sub > Cursor Operation or

Insert > Cursor Operation.
See About Creating Map Objects for more information on the Create Sub and
Insert functions.
The system displays the ODBC Cursor Operation Record Properties dialog box.

2. On the Name tab, enter a unique cursor operation record name and description
(if applicable).

3. Select the Cursor Operation tab.
4. From the Query Record Association list, select the query that the system uses to

obtain a result set that is then moved to the record.
5. Select the cursor operation.
6. Click OK.

The system saves the cursor operation record and closes the ODBC Cursor
Operation Record Properties dialog box.

Input Records
An input record contains a logical group of fields that are suitable to be mapped to
the output format.

For example:

The input side of the map is ODBC and the output file format is Positional, and
you need to generate a record using information from two separate queries. You
can create an ODBC input record that contains fields which obtain data from the
appropriate columns of both queries. Then you can link those fields directly to the
corresponding positional fields.
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Note: The input record cannot be referenced by standard rules or links.

Key field functionality

Input records support the standard Sterling Gentran:Server key field constant and
code list functionality. Additionally, the system provides you with the ability to
match against fields that appear earlier in the map. If you choose to match against
an earlier mapped field, you are allowed up to three key fields.

This additional key field functionality is very useful when you are mapping from a
join of master-detail records to an equivalent hierarchy, because this allows the
translator to detect when the keys in the detail level no longer match the keys in
the master level.

Auto get next cursor operation

If the fields of an input record all belong to the same query, you can specify that
the system automatically perform an auto get next cursor operation as the input
record loops.

Note: You specify the "Automatically get next row from Statement record" option
on the Looping tab of the ODBC Input Record Properties dialog box.

ODBC Input Record Properties - Name Tab
This table describes the parts of the ODBC Input Record Properties Name tab.

Part Function

Name Defines the name of the input record.
Note: Do not use spaces or dashes (-) for the name. You can
use the underscore (_) to separate words.

Description Describes the input record to differentiate it from other similar
records.

ODBC Input Record Properties - Key Field Tab
This table describes the parts of the ODBC Input Record Properties Key Field tab.

Part Function

None, Use constant, Use
codelist, Use Field

Indicates the type of information that the system uses to match
this record.
Note: Selecting Use constant or Use codelist activates the
middle section of the dialog box. Selecting Use Field activates
the bottom section of the dialog box.

Match record when key
does not match

Indicates that the system should (if selected) match the record if
the Key Field does not have the value specified.
Note: This gives you the ability to further recognize an
ambiguous record definition.

Key Field Contains the field that the system verifies to check if it does or
does not (depending on which you specify) match the constant,
code list, or field value or values.

Constants/Edit Contains a list of defined constants. The system will match the
selected constant against the key field.

To add or change a constant, click Edit to access the Translation
Object Constants dialog.
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Part Function

Code Lists/Edit Contains a list of defined code lists. The system will match the
selected code list against the key field.

To add or change a code list, click Edit to access the Code Lists
dialog.

Key Field 1 Specifies the first key field.
Note: Contains all the active fields from this record.

Use Key Field 1 Specifies that the system should use this value.
Note: Contains all the active fields from the preceding records
(not including this record).

Key Field 2 Specifies the second key field, if necessary.
Note: Contains all the active fields from this record.

Use Key Field 2 Specifies that the system should use this value.
Note: Contains all the active fields from the preceding records
(not including this record).

Key Field 3 Specifies the third key field, if necessary.
Note: Contains all the active fields from this record.

Use Key Field 3 Specifies that the system should use this value.
Note: Contains all the active fields from the preceding records
(not including this record).

ODBC Input Record Properties - Looping Tab
This table describes the parts of the ODBC Input Record Properties Looping tab.

Part Function

Min Usage Specifies the minimum amount of times the loop must repeat.
Note: If the Min Usage box contains a "0" (zero), the record is
"conditional." If the Min Usage box contains a "1" or greater, the
record is "mandatory".

Max Usage Specifies the maximum amount of times the loop can repeat.

Normal, Loop Start, Loop
End

Indicates the type of loop. Valid values are:

v Normal (This record is in the loop but is not the beginning or
ending record)

v Loop Start (This record marks the beginning of the loop)

v Loop End (This record marks the end of the loop)

Automatically get next
row from Statement
record

Indicates that the system performs a movement operation as
the input record loops.

ODBC Input Record Properties - Loop Extended Rules Tab
This table describes the parts of the ODBC Input Record Properties Loop Extended
Rules tab.

Part Function

On Begin Specifies that the extended rule is executed before the system
processes the record.

On End Specifies that the extended rule is executed after the system
concludes processing the record.

Full Screen Maximizes the dialog box.
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Part Function

Compile Compiles the extended rule. Any warnings or errors are
displayed in the Errors list.
Note: This function gives you immediate feedback about the
accuracy of your rule. The rule is compiled when you compile
the entire translation object.

Extended rule Defines the extended rule.

Errors Displays any errors generated when you clicked Compile to
compile the extended rule.

Creating an Input Record
About this task

Use this procedure to create an input record.

Procedure
1. Right-click a map object and select either Create Sub > Input Record or Insert

> Input Record .
See About Creating Map Objects for more information on the Create Sub and
Insert functions.
The system displays the ODBC Input Record Properties dialog box.

2. On the Name tab, enter a unique input record name and description (if
applicable).

3. Select the Key Field tab and select the appropriate options to define the key
field.

4. Select the Looping tab.
5. In the Maximum usage box, type the number of times the record can repeat

(loop).
6. If necessary, specify that the system automatically gets the next row from the

statement record order/join.
7. If the record repeats (loops) and you want to specify an extended rule for this

input record, select the Loop Extended Rules tab and define the rule.
See the IBM Sterling Gentran:Server for Microsoft Windows Application Integration
User Guide for more information on extended rules.

8. Click OK.
The system saves the input record and closes the ODBC Input Record
Properties dialog box.

Output Records
An output record represents an update, insert, or delete SQL statement, and
contains database output fields. You specify the name of the table the system
modifies and whether to insert, update, or delete.

The fields contained within an output record represent the columns the system is
updating or inserting and the key to the affected row or rows. Output records may
be created on both the input and output sides of a map.

Note: The output record cannot be referenced by standard rules or links.
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Important: Any ODBC map that uses an ODBC Output Record and is translating
against a Microsoft database (Access or SQL Server) must turn on (activate) the
"Use ANSI Quoted Identifiers" option in the ODBC DSN configuration.

Key field functionality

Output records support the standard Sterling Gentran:Server key field constant
and code list functionality. Additionally, the system provides you with the ability
to match against fields that appear earlier in the map. If you choose to match
against an earlier mapped field, you are allowed up to three key fields.

This additional key field functionality is very useful when you are mapping from a
join of master-detail records to an equivalent hierarchy, because this allows the
translator to detect when the keys in the detail level no longer match the keys in
the master level.

Auto get next cursor operation

If the fields of an output record all belong to the same query, you can specify that
the system automatically perform an auto get next cursor operation as the output
record loops.

Note: You specify the "Automatically get next row from Statement record" option
on the Looping tab of the ODBC Output Record Properties dialog box.

ODBC Output Record Properties - Name Tab
This table describes the parts of the ODBC Output Record Properties Name tab.

Part Function

Name Defines the name of the output record.
Note: Do not use spaces or dashes (-) for the name. You can
use the underscore (_) to separate words.

Description Describes the output record to differentiate it from other similar
records.

ODBC Output Record Properties - SQL Operations Tab
This table describes the parts of the ODBC Output Record Properties SQL
Operations tab.

Part Function

Data Source Contains a list of the associated data sources.

Table Contains a list of the database tables for the selected data
source.

Insert, Update, Delete Indicates which operation the system performs against the
table.
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Part Function

On failure, automatically
switch selected operation
and retry Inserts as
Updates or Updates as
Inserts

Indicates (if selected) that if the operation fails then the system
will automatically switch the operation type (that is, update to
insert or insert to update) and retry the operation.
Note: When the Delete option is selected, this check box is
inactive because it does not apply to the delete operation.
Important: If you have upgraded from a previous version of
Sterling Gentran:Server and you are using the retry feature, you
must update your ODBC maps by selecting this checkbox for
every output record in the map.

ODBC Output Record Properties - Key Field Tab
This table describes the parts of the ODBC Output Record Properties Key Field tab.

Part Function

None, Use constant, Use
codelist, Use Field

Specifies the type of information that the system uses to match
this record.
Note: Selecting Use constant or Use code list activates the
middle section of the dialog box. Selecting Use Field activates
the bottom section of the dialog box.

Match record when key
does not match

Indicates that the system should (if selected) match the record if
the Key Field does not have the value specified.
Note: This gives you the ability to further recognize an
ambiguous record definition.

Key Field Contains the field that the system verifies to check if it does or
does not (depending on which you specify) match the constant,
code list, or field value or values.

Constants/Edit Contains a list of defined constants. The system will match the
selected constant against the key field.

To add or change a constant, click Edit to access the Translation
Object Constants dialog.

Code Lists/Edit Contains a list of defined code lists. The system will match the
selected code list against the key field.

To add or change a codelist, click Edit to access the Code Lists
dialog.

Key Field 1 Specifies the first key field.
Note: Contains all the active fields from this record.

Use Key Field 1 Specifies that the system should use this value.
Note: Contains all the active fields from the preceding records
(not including this record).

Key Field 2 Specifies the second key field, if necessary.
Note: Contains all the active fields from this record.

Use Key Field 2 Specifies that the system should use this value.
Note: Contains all the active fields from the preceding records
(not including this record).

Key Field 3 Specifies the third key field, if necessary.
Note: Contains all the active fields from this record.

Use Key Field 3 Specifies that the system should use this value.
Note: Contains all the active fields from the preceding records
(not including this record).
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ODBC Output Record Properties - Looping Tab
This table describes the parts of the ODBC Output Record Properties Looping tab.

Part Function

Min Usage Specifies the minimum amount of times the loop must repeat.
Note: If the Min Usage box contains a "0" (zero), the record is
"conditional." If the Min Usage box contains a "1" or greater, the
record is "mandatory".

Max Usage Specifies the maximum amount of times the loop can repeat.

Normal, Loop Start, Loop
End

Indicates the type of loop. Valid values are :

v Normal (This record is in the loop but is not the beginning or
ending record)

v Loop Start (This record marks the beginning of the loop)

v Loop End (This record marks the end of the loop)

Automatically get next
row from Statement
record

Indicates that the system performs a movement operation as
the output record loops.

ODBC Output Record Properties - Loop Extended Rules Tab
This table describes the parts of the ODBC Output Record Properties Loop
Extended Rules tab.

Part Function

On Begin Specifies that the extended rule is executed before the system
processes the record.

On End Specifies that the extended rule is executed after the system
concludes processing the record.

Full Screen Maximizes the dialog box.

Compile Compiles the extended rule. Any warnings or errors are
displayed in the Errors list.
Note: This function gives you immediate feedback about the
accuracy of your rule. The rule is compiled when you compile
the entire translation object.

Extended rule Defines the extended rule.

Errors Displays any errors generated when you clicked Compile to
compile the extended rule.

Creating an Output Record
About this task

Use this procedure to create an output record.

Procedure
1. Right-click a map object and select either Create Sub > Output Record or

Insert > Output Record.
See About Creating Map Objects for more information on the Create Sub and
Insert functions.
The system displays the ODBC Output Record Properties dialog box
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2. On the Name tab, enter a unique output record name and description (if
applicable).

3. Select the SQL Operation tab to access the output options.
4. Select the appropriate data source.
5. Select the table you want to modify.
6. Select the appropriate table operation.
7. If necessary, select the option to automatically switch the specified operation

(for example, insert to update or update to insert) and retry the operation
again.

8. Select the Key Field tab and select the appropriate options to define the key
field.

9. Select the Looping tab.
10. In the Maximum usage box, enter the number of times the record can repeat

(loop).
11. If the record repeats (loops) and you want to specify an extended rule for this

output record, select the Loop Extended Rules tab and define the rule.
See the IBM Sterling Gentran:Server for Microsoft Windows Application Integration
User Guide for more information on extended rules.

12. Click OK.
The system saves the output record and closes the ODBC Output Record
Properties dialog box.

Fields
A field behaves differently depending on whether it is located in an input or
output record.

Note: A field does not have to be associated with a query.

The system automatically selects the field type if you previously generated schema
or result set information. If you did not generate a schema or result set, you must
specify the field type manually.

Note: When a field has an operation performed against it (link, standard rule, or
as an extended rule storage field), the system displays a red checkmark over the
field icon.

Field in an input record

If the field is located in an input record, the field receives data from a column in
the current row of a result set of a query. You associate the field with a column
returned by a query.

Note: Column names are not available if you do not test the selected query.
Instead, you must select a column number.

Field in an output record (output side of map)

If the field is located in an output record on the output side of the map, the field
represents a column the system updates or inserts, or a key column. You specify
the name of the column and indicate if it is a key. The system uses key columns
automatically to build a "where" clause for update and delete statements.
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Note: If the field is contained in an output record, the validation information is set
from the column to which it is mapped.

Field in an output record (input side of map)

If the field is located in an output record on the input side of a map, you can
specify both where the column is from and where the column data is going to in
the target table.

Note: If the field is contained in an output record, the validation information is set
from the columns information.

Field Properties - Name Tab
This table describes the parts of the Field Properties Name tab.

Part Function

Name Defines the name of the field.
Note: Do not use spaces or dashes (-) for the name. You can
use the underscore (_) to separate words.

Description Describes the field to differentiate it from other similar fields.

Field Properties - Query Tab
This table describes the parts of the Field Properties Query tab.

Part Function

Associated Statement
Record

Contains a list of statement records.

Query SQL Displays the SQL for the currently selected statement record.

Name Contains a list of column names in the result set of the
currently selected statement record.
Note: This is only applicable if you specified to connect to the
database and tested the SQL.

Number Contains a list of column numbers in the result set of the
currently selected statement record.
Note:

v This is only applicable if you specified to connect to the
database and tested the SQL.

v This list uses a one-based index.

Nulls Allowed Indicates whether nulls are allowed in the column selected
from the Name list.
Note: For informational purposes only.

Clear Disassociates this field from any query.

Field Properties - Column Tab
This table describes the parts of the Field Properties Column tab.

Part Function

Name Contains a list of column names in the table which is associated
with the parent output record.
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Part Function

Number Contains a list of column numbers in the table which is
associated with the parent output record.

Nulls Allowed Indicates whether the system will fill in a blank field with nulls
during insert and update SQL statement operations to the
column selected from the Name list.

Table Key Indicates that this field will be used in a where clause.
Note: This enables the system to format "where" clauses used
in an update or delete (not applicable for insert operations).

Clear Disassociates this field from any query.

Field Properties - Validation Tab
This table describes the parts of the Field Properties Validation tab.

Part Function

Mandatory Indicates whether the field is mandatory (must appear).

Minimum Specifies the minimum length of the field.

Maximum Specifies the maximum length of the field.

Data-type Specifies the type of data. Valid values are:

v String (alphanumeric element)

v Number (numeric or real element)

v Date/Time (date or time element)

Format Specifies how the field is formatted.
Note: Depending on which Data-type you selected, you can
either select the data format from a list (if you choose Number
or Date/Time in the Type field), or enter a Syntax Token to
denote that this field must be formatted as the specified Syntax
Token dictates.

When you installed Sterling Gentran:Server, you assigned a
default format to the string fields. This format serves as the
basis for character validation. Most U.S. users use a default
format that corresponds to ASCII characters (for example, the X
syntax token). Most users of Asian or European languages and
encoded character sets should use the Free Format (0x01-0xFF).

Field Properties - Standard Rule Tab
This table describes the parts of the Field Properties Standard Rule tab.

Part Function

Standard rule Specifies a standard rule that will affect this field or element
during processing. Each of the rules are mutually exclusive.

See the IBM Sterling Gentran:Server for Microsoft Windows
Application Integration User Guide for more information on
standard rules.
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Field Properties - Extended Rule Tab
This table describes the parts of the Field Properties Extended Rule tab.

Part Function

Full Screen Maximizes the dialog box.

Compile Compiles the extended rule. Any warnings or errors are
displayed in the Errors list.
Note: This function gives you immediate feedback about the
accuracy of your rule. The rule is compiled when you compile
the entire translation object.

Extended rule Defines the extended rule.

Errors Displays any errors generated when you clicked Compile to
compile the extended rule.

Creating a Field
About this task

Note: See the IBM Sterling Gentran:Server for Microsoft Windows Application
Integration User Guide for more information on standard and extended rules.

Use this procedure to create a field.

Procedure
1. Right-click a map object and select either Create Sub > Field or Insert > Field.

See About Creating Map Objects for more information on the Create Sub and
Insert functions.
The system displays the Field Properties dialog box.

2. On the Name tab, enter a unique field name and description (if applicable).
3. If this field is on the input side of the map, select the Query tab and do the

following:
a. Select the record with which this field is associated.
b. Select the table name.

Note: If the Name list is not available, this indicates that you did not test
the SQL query. Instead, select a number from the Number box.

c. To allow nulls, select Nulls Allowed.
4. If this field is on the output side, select the Column tab and do the following:

a. For the output side of the map, on the Column tab, select the column name.

Note: If the Name list is not available, this indicates that you did not select
to connect to a data source to build a table in the ODBC File Properties
dialog box. Instead, select a number from the Number box.

b. To allow nulls, select Nulls Allowed.

Note: This option is only applicable for fields in an output record.
c. If this field will be used in a where clause, select Table Key.

5. On the Validation tab, specify the following:
v whether or not the field is required
v minimum length
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v maximum length
v type of data
v how the data is formatted

6. To specify a standard rule for this field, select the Standard Rule tab and define
the rule.

7. To specify an extended rule for this field, select the Extended Rule tab and
define the rule.

8. Click OK.
The system saves the field and closes the Field Properties dialog box.

Checking Database Consistency
The Check Database Consistency function compares the definitions of each query,
output record, and field with the associated data source, and returns a list of any
inconsistencies. This function alerts you to inconsistencies in your database, but
does not fix your map components.

About this task

Note: The system also checks database consistency when you update the data
source (on the Data Source tab of the ODBC File Format Properties dialog box) and
as the first action of compiling the map. For example: An inconsistency occurs if a
field tries to extract data from a query column that is not returned by the data
source.

Use this procedure to check database consistency.

Procedure
1. Right-click an ODBC file format object and select Check Database Consistency.

The system verifies the consistency of the selected side of the map and displays
the File Format Consistency Check dialog, which displays any inconsistencies.

2. Click OK.
The system closes the File Format Consistency Check dialog box.

Outbound ODBC Mapping when No Partner is Found
This section describes the setup of outbound ODBC maps when a valid partner
relationship is not found during partner lookup.

The translator does not know when a row of data in the database has been
processed. You must write SQL queries to pull data based on a certain column
containing a specific value and then update a new value back to the column in the
import map. This status column indicates if a row has been processed or not.

If a valid partner relationship is not found, the Import map will not be invoked
and the column will not get the updated value. This means that the translator will
be stuck in an infinite loop on that particular row of data. An update must be
added to the system import header map to prevent the infinite loop.

You need to modify the system import header map and the outbound/import map
to avoid this problem. You need to have more than just two values for the status
column to tell Sterling Gentran:Server that a particular row has been processed.
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For this example, we will use the values 1 - 4.
v 1 = Unprocessed. This is the value that the system import header map looks for

in the SQL statement.
v 2 = Processed by system import map. This does not indicate that a partner has

been found.
v 3 = Partner relationship found and processed by the import map.
v 4 = No partner found by system import header map.

The following shows a typical system import header map before any modifications
that accommodate not finding a partner relationship.

System Import Header Map Changes

For this example, we made the following changes to the system import header
map:
1. 1. Add a query Statement Record directly under the ODBC file format object

(INPUT level). This SQL Statement will update the value 2 to 4 to prevent the
import map from processing a row of data that does not have an associated
partner relationship in Sterling Gentran:Server.
Example SQL statement:
UPDATE Table SET STATUS = 4 Where STATUS = 2

2. 2. Add an update record at the end of the INPUT side that updates the STATUS
column to 2.
a. Include the table key(s) in the update record and mark them as Table Key

on the Column tab.
b. Associate the columns in the update record with the statement record. This

will populate the fields with data.
c. Place a standard or extended rule on the status column that updates the

value to 2.

The map now looks like this:

Import Map Changes

We then made the following changes to the system import header map:
1. Change the SQL statement to pull data based on the status column being equal

to . This is the value that the system import header map will update. (The
Import map will not be invoked if a partner relationship is not found.)

2. Change the update record to update the status column to 3.
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The map now looks like this:

Results

The following are the results of the modifications to the maps:
v The system import map pulls data based on the status column being equal to 1.

The system import map will update this column to 2 if it finds a partner or not.
v If the system import header map finds a partner relationship:

1. The import map is invoked and pulls data based on the status column being
equal to the value of 2.

2. The status column is updated to a value of 3.
v If the system import header map does not find a partner relationship:

1. The import map is never invoked.
2. The system import head map is invoked a second time.
3. Any status column that contains a 2 is updated to 4.
4. Any status column that contains a 1 is updated to 2.

Note: You should never see the status column with a value of 2 in the database,
unless you are checking it during translation.
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Chapter 3. ODBC Map Tutorial

About the ODBC Tutorial
The following topics contain a tutorial for theSterling Gentran:Server Application
Integration subsystem, using ODBC. In this tutorial, you will create an import map
with ODBC as the input format and Positional as the output format.

To access reference information, see the IBM Sterling Gentran:Server for Microsoft
Windows Application Integration User Guide. For additional information on the
various tasks described, refer to the IBM Sterling Gentran:Server for Microsoft
Windows User Guide.

Before you Begin

In the Pubs database, add the following column to the Sales_tb file:
processed TinyInt NotNULL default value=1

Also, create a DSN called PubsDB (case does not matter) and point it to the Pubs
database.

Note: Open the map and update the schema to make sure it can see the database.
If it states that the columns are not linked to the database, it is because you have a
different MDAC installed. The mapper will generate the fields differently
depending on what version of MDAC you have.

Outbound Map

Creating a Query into the Database
About this task

In this task, you will do the following:
v Connect the map to the database (steps 1 - 4).
v Create a query that will retrieve the necessary information from the database

(steps 5 - 12).

Procedure
1. Right-click the ODBC file format (Input) and select Properties.
2. Click the Data Sources tab.
3. Click ODBC Data Sources and select the DSN for your Pubs database

(PubsDB).
4. After ensuring that all information is correct, click Add and then click Test

Connection.
Select dbo.sales and dbo.stores.

5. Right-click on ODBC File Format and select Create Sub > Query/Command.
6. Name the query GetInfo.
7. Click the SQL tab.
8. Select the appropriate data source.
9. Enter the following SQL statement:
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Select * from stores, sales
Where stores.stor_id = sales.stor_id
And processed = 1

10. Click Test SQL to check the validity of the statement.
11. Select Returns a Result Set and click OK.

Populating the Map with Data from the Stores Table
About this task

In this task, you will do the following:
v Create the structure to hold the data from the Stores table (steps 1 - 7).
v Create the Output Record to update the column in the database (steps 8 - 18).

Procedure
1. Right-click the GetInfo query and select Insert > Group.
2. Name the group SalesINFO with a maximum repeat of 100.
3. Right-click the SalesINFO group and select Create Sub > Input record.
4. Name the record StoreInfo with a maximum repeat of 1.
5. Right-click the StoreInfo input record and select Generate Fields.
6. Select the GetInfo query.
7. Select all fields from the Stores table and click Finish.
8. Right-click the StoreInfo input record and select Insert > Output record.
9. Name the record UpdateTable.

10. Right-click the UpdateTable input record and select Properties.
11. Click the SQL Operation tab and do the following:

v Select the data source.
v Select dbo.Sales as the table/view.
v Select Update.

12. Right-click the UpdateTable output record and select Generate Fields.
13. Select the GetInfo query and select Sales.stor_id and Sales.processed

columns and click Finish.
14. In the UpdateTable output record, right-click the stor_id field and select

Properties.
15. On the Query tab, select GetInfo as the Associated Statement Record.
16. On the Column tab, select Table Key.
17. In the UpdateTable output record, right-click the processed field and select

Properties.
18. On the Query tab, select GetInfo as the Associated Statement Record.
19. On the Extended Rules tab, enter the following:

#processed = 2;

Populating the Map with Data from the Sales Table
About this task

In this task, you will do the following:
v Create the structure to hold the data from the Sales table (steps 1 - 7).
v Set up the key fields (steps 8 - 9).
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Procedure
1. Right-click the UpdateTable output record and select Insert > Input record.
2. Name the group Sales.
3. Right-click the Sales record and select Properties.
4. On the Looping tab, enter a maximum repeat of 100.
5. Select Automatically get next row from Statement record GetInfo.
6. Right-click the Sales input record and select Generate Fields.
7. Select the GetInfo query.
8. Select all fields from the Sales table (except the Processed column) and click

Finish.
9. Right-click the Sales input record and select Properties.

10. Click the Key Field tab and do the following:
v Select Use Field.
v For Key Field 1, select sales_stor_id.
v For Use Field 1, select stores_stor_id.

Creating the Output Side of the Map
About this task

The positional output file has been provided for you.

Procedure
1. Right-click on the output file format object and select Open File Format

Definition.
2. A warning will appear asking if you really want to do this, click Yes.
3. Navigate to the \\Gensrvnt\ODBC Exercises directory and select the

PubsOutput.ddf file.
4. Link the associated input fields to the output.

Note: You will not link any fields in the UpdateTable output record to the
output side.

5. Save and compile the map.

Creating the System Import Map
Procedure
1. Do a Save as on the Import map.

The new mapped saved will be the system Import map.
2. Change the map description to System ODBC Map.
3. Change the type to System Import Header.
4. Remove all links and delete the Update Record.
5. Create a field at the bottom of the Stores input record and name it Partner,

string of 10.
6. Under the SalesINFO group and StoreInfo record, right-click the store_stor_id

field and add the following extended rule:
Update Document set appfield1 = “1.0”;
Update Document set appfield2 = “SALORD”;
#Partner = “PubsTest”;

7. On the Partner field just created, add the Select Partner by Alternate Code
Standard Rule.
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8. Save and compile the map.

Processing the Outbound Map
Procedure
1. Register the system import map and the import map.
2. Register I_NoBld.tpl and T_NoBld.tpl.
3. Import the partner profile.
4. Create a file called Fake.txt in the \\gensrvnt\imports directory.
5. Open Sterling Gentran:Server configurations and select the Imports tab.
6. Create a new entry and point the file path directly to the fake file.
7. From the desk, open the Workspace.
8. Click Import and navigate to the fake.txt file and select Open.
9. If the map is processed OK, post and send the document.

If the map is processed NotOk, debug the errors and reprocess the file.

Inbound Map

Creating the ODBC Output Format
Create an export map with EDI as the input format and ODBC as the output
format.

About this task

In this task, you will do the following:
v Connect the map to the database (steps 1 - 4).
v Create the structure to obtain data from database (steps 5 - 17).

Procedure
1. Right-click the ODBC file format and select Properties.
2. Click the Data Sources tab.
3. Click ODBC Data Sources and select the DSN for your Pubs database

(PubsDB).
4. After ensuring that all information is correct, click Add and then click Test

Connection.
5. Right-click the ODBC file format and select Create Sub > Group.
6. Name the group SalesInfo with a maximum repeat of 1000.
7. Right-click the SalesInfo group and select Create Sub > Output record.
8. Name the record Stores.
9. Click the ODBC Output Record tab and do the following:

v Select the Pubs data source.
v Select dbo.stores as the table/view.
v Select Insert.

10. Right-click the Stores input record and select Generate Fields.
11. Select all fields from the Stores table and click Finish.
12. Right-click the Stores output record and select Insert > Output record.
13. Name the record Sales with a maximum repeat of 1000.
14. Click the ODBC Output Record tab and do the following:
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v Select the Pubs data source.
v Select dbo.Sales as the table/view.
v Select Insert.

15. Right-click the Sales output record and select Generate Fields.
16. Select all columns from the Sales table and click Finish.
17. On the Extended Rules tab, enter the following to the processed field:

Processed = 1;

Creating the Input Side of the Map
About this task

The DDF for the input side has been provided for you.

Procedure
1. Right-click the input file format object and select Open File Format Definition.
2. A warning will appear asking if you really want to do this, click Yes.
3. Navigate to the \\Gensrvnt\ODBC Exercises directory and select PubsInput.ddf.
4. Link all corresponding fields to the output side.
5. Save and compile the map.

Processing the Inbound Map
Procedure
1. Register the export map.
2. Process the ODBC_Export.txt file.
3. If the map is processed OK, export the file and enter any filename for the

export.

Note: It will not create the file, Sterling Gentran:Server only needs a filename
to kick off translator.
If the map is processed NotOK, debug the errors and reprocess the file.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.S.A.

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law

IBM Japan Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku

Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
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incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation

J46A/G4

555 Bailey Avenue

San Jose, CA 95141-1003

U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.
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This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© IBM 2012. Portions of this code are derived from IBM Corp. Sample Programs. ©
Copyright IBM Corp. 2012.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at http://www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

IT Infrastructure Library is a registered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government
Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.
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Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

ITIL is a registered trademark, and a registered community trademark of the Office
of Government Commerce, and is registered in the U.S. Patent and Trademark
Office.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java™ and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the
United States, other countries, or both and is used under license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are
trademarks of HP, IBM Corp. and Quantum in the U.S. and other countries.

Connect Control Center®, Connect:Direct®, Connect:Enterprise®, Gentran®,
Gentran®:Basic®, Gentran:Control®, Gentran:Director®, Gentran:Plus®,
Gentran:Realtime®, Gentran:Server®, Gentran:Viewpoint®, Sterling Commerce™,
Sterling Information Broker®, and Sterling Integrator® are trademarks or registered
trademarks of Sterling Commerce®, Inc., an IBM Company.

Other company, product, and service names may be trademarks or service marks
of others.

40 IBM Sterling Gentran:Server for Windows: ODBC User Guide



Index

A
Auto get next cursor operation

input records 17, 19
output records 20, 23

C
check database consistency function 28
connecting a map to a database

tutorial 31
Create Sub function 9
creating a map structure

tutorial 32
creating the input side of a map

tutorial 35
creating the output format

tutorial 34
creating the output side of a map

tutorial 33
creating the system import map

tutorial 33
customer support 1

D
data sources

creating 12
file format properties 10

database
creating queries 15
file format properties 10
queries 14, 15

database schema 1

E
errors

extended rules 27
extended rules

errors 27
fields 27
looping 11, 13, 23
looping properties 19

F
fields

check consistency 28
creating 27
extended rules 27
input records 24
naming 25
output records 24
queries 25
standard rules 26
tables 25
types 26
validation 26

file format object 9

file properties
modifying 11

filenames
file format properties 10

functions
check database consistency 28
Create Sub 9
Generate Fields 6, 7
Insert 9

G
Generate Fields function 6, 7
groups

creating 14
group name 13

I
import maps 5
inbound mapping 3
input record

extended rules 19
input records

creating 20
generating fields 6
key field 18
looping 19
name 18
overview 17

Insert function 9

K
key field function

creating an input record 20
creating an output record 23
input records 17, 18
output records 20, 22

L
looping

creating an input record 20
creating an output record 23
extended rules 11, 23

looping properties
extended rules 13, 19
groups 13
input records 19
output records 23

M
map creation process 3
map objects

creating 9
icons 2

map types 2

maps
creating 5
import maps 5

N
New Map Wizard

creating maps 5
no partner found

outbound map 28

O
outbound map

no partner found 28
outbound mapping 3
output maps

creating an input record 20
input records 17, 18, 19

output records
check consistency 28
creating 23
extended rules 23
generating fields 6, 7
key field 22
looping 23
name 21
overview 20
SQL operations 21

P
populating a map

tutorial 32
populating a map with data

tutorial 32
processing the inbound map

tutorial 35
processing the outbound map

tutorial 34

Q
queries

check consistency 28
names 15

query results
cursor operation 16, 17

R
records

creating 15
creating an input record 20
creating an output record 23
creating fields 27
cursor operation 16, 17
generating fields 6, 7
input records 17, 18, 19

© Copyright IBM Corp. 1996, 2012 41



records (continued)
names 15
output records 20, 21, 22, 23
overview 14
properties 15

S
setting up key fields

tutorial 32
SQL operations 21
SQL queries

creating 15
field properties 25
overview 14
properties 15
tutorial 31

standard rules
fields 26

statement records
creating 15
names 15
overview 14
properties 15

T
timestamps 1

42 IBM Sterling Gentran:Server for Windows: ODBC User Guide





����

Product Number: 5725-D09

Printed in USA


	Contents
	Chapter 1. Getting Started
	ODBC with Sterling Gentran:Server
	About ODBC Maps
	ODBC Map Creation Process
	Considerations for ODBC Mapping
	Creating an ODBC Map
	Additional Steps for Import Maps
	The Generate Fields Function
	Generating Input Record Database Fields
	Generating Output Record Database Fields
	Moving from Test to Production

	Chapter 2. Working with ODBC Map Objects
	About Creating Map Objects
	ODBC File Format Object
	ODBC File Format Properties - Name Tab
	ODBC File Format Properties - Data Sources Tab
	ODBC File Format Properties - Loop Extended Rules Tab
	Modifying ODBC File Format Properties
	Creating an ODBC Data Source

	Groups
	Group Properties - Name Tab
	Group Properties - Looping Tab
	Group Properties - Loop Extended Rules Tab
	Creating a Group

	Statement Records
	ODBC Statement Record Properties - Name Tab
	ODBC Statement Record Properties - SQL Tab
	Creating a Statement Record

	Cursor Operation Records
	ODBC Cursor Operation Record Properties - Name Tab
	ODBC Cursor Operation Record Properties - Cursor Operation Tab
	Creating a Cursor Operation Record

	Input Records
	ODBC Input Record Properties - Name Tab
	ODBC Input Record Properties - Key Field Tab
	ODBC Input Record Properties - Looping Tab
	ODBC Input Record Properties - Loop Extended Rules Tab
	Creating an Input Record

	Output Records
	ODBC Output Record Properties - Name Tab
	ODBC Output Record Properties - SQL Operations Tab
	ODBC Output Record Properties - Key Field Tab
	ODBC Output Record Properties - Looping Tab
	ODBC Output Record Properties - Loop Extended Rules Tab
	Creating an Output Record

	Fields
	Field Properties - Name Tab
	Field Properties - Query Tab
	Field Properties - Column Tab
	Field Properties - Validation Tab
	Field Properties - Standard Rule Tab
	Field Properties - Extended Rule Tab
	Creating a Field

	Checking Database Consistency
	Outbound ODBC Mapping when No Partner is Found

	Chapter 3. ODBC Map Tutorial
	About the ODBC Tutorial
	Outbound Map
	Creating a Query into the Database
	Populating the Map with Data from the Stores Table
	Populating the Map with Data from the Sales Table
	Creating the Output Side of the Map
	Creating the System Import Map
	Processing the Outbound Map

	Inbound Map
	Creating the ODBC Output Format
	Creating the Input Side of the Map
	Processing the Inbound Map


	Notices
	Index
	A
	C
	D
	E
	F
	G
	I
	K
	L
	M
	N
	O
	P
	Q
	R
	S
	T


